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BASIC MICROSOFT
EXCEL

PHONE: IT Training Team EMAIL:

504-838-1144 Jefferson Parish Library jpltrain@jplibrary.net



In this class you will learn to:

- Launch and interact with Microsoft Excel 2016
« Create new workbooks

« Navigate through a spreadsheet

« Select cells

« Enter and delete data

- Dragand drop cells

«  Work with columns and rows
- Save a workspace
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Meeting Microsoft Office Excel 2016

What is Microsoft Office Excel 2016?

* The number 2016 is simply the year Microsoft chose
to release an update of Excel. The spreadsheet
program first appeared in 1982. Today, users who
want to have the most up-to-date version of the
program consider subscribing to Office 365, which is
a part of Microsoft 365.

e A spreadsheet is essentially a large flexible grid that
is used to hold information, usually numerical.

e Using Excel, you can analyze large amounts of data,
move sets of data around to get a different picture of
your figures, and generate a number of different
charts and diagrams to help summarize the data.

Source for bullet one: https://www.excelhelp.com/the-history-of-microsoft-excel/
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LAUNCHING EXCEL

E

XH Excel2016 k

To open Microsoft Office Excel 2016: F
O o dback Hub

* Click the Start menu. B | e

* Scroll down to the “E” section.

G
Q Get Help
* Click Excel 2016. ]

GIMP 2.10.8

Google Chrome

Groove Music
You can also open Excel if you have an
Excel icon on your desktop: Tunes

* Double-click the icon to open Excel

o3

~
Q Maps

MaxxAudioPro

Excel 2016

oif




INTERFACE OVERVIEW:

. QUICK ACCESS TOOLBAR This
specialized toolbar provides quick
access to the commands you use
most often.

. TABS Click to view commands
specific to the tab name. For
example, the Page Layout tab lets
you change the paper size,
margins, paragraph settings, etc.

. RIBBON The ribbon is a set of
toolbars located just below the
tabs. Itis designed to help you
quickly find the commands that
you need to complete a task. The
quickest way to show the ribbon is
to click on any visible tab, like
Home, Insert or View.

. NAME BOX Shows the name of
the currently selected cell, called
the active cell.

JHL

Jefferson Parish Library

LAUNCHING EXCEL

Insert

Sheetl

1. QUICK ACCESS TOOLBAR

Page Layout Formulas Data I Q Tell me what you want to do... Sign in IQ!_ Share

1 Adl==R % =5 General v F@Conditional Formatting ~ E"’Insen = z =
. : | e $ -~ % » [#FormatasTable~ PXDelete ~+ [T L
"AC | EE=E2H g (7 Cell Styles - & Format~ | & -
Font Alignment ' Number @& Styles Cells Editing
£ 2. TABS v
€ D E F G H | J K L M N ||
4. NAME BOX 3. RIBBON
® ‘ ;




LAUNCHING EXCEL

5. FORMULA BAR

INTERFACE OVERVIEW: Formulas  Data

5. FORMULA BAR Allows you to [ g . | MU
enter data in a cell. Data can be d . TG
alphanumeric, pictures, symbols or | clieboars = Font
formulae. A1 - | =

6. WORKING AREA Here is where A B c D 3 F G H [ ) K L M N
you will type the data into the
spreadsheet.

7. WORKBOOK TABS A workbook
can contain one or more
worksheets, just like an accounting
ledger can contain one or more
pages. Click these tabs to switch
between the different worksheets.

8. STATUS BAR The status bar is
used to display information about
the workbook. Any running
calculations will be shown here.

9. SCROLL BAR Not all of the
information in a worksheet will fit 7. WORKBOOK TABS 8. STATUS BAR 9. SCROLL BAR

on the screen, so use the scroll bars |22| z : , | , , -
to scroll horizontally or vertically I Sheet! ® | C :

Sign in ,Q,_ Share

Q Te
General v % Conditional Formatting ~ gm Insert ~ 2.
$ - % » [FormatasTable~ &% Delete ~ * P~
50 3% [Z7 Cell Styles ~ =1 Format~ &
™ Alignment = Number @& Styles Cells Editing

=
e=3= B -

sl ?

I

0 ~N O U W N -

o

6. WORKING AREA

NN |t | |t |k |t |omd |omd [ | b |
= O W 0 ~N O WU Ak WN = O

through the data. e
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COMPONENTS OF A WORKSHEET

The spreadsheet is made up of rows and columns. The intersection of a row and columnis
called a cell.

* A column is a vertical series of A B C 0

adjacent cells from top to bottom.
Column

* Arow is a horizontal series of cells
from left to right.

PR TR R S

* A cell describes the intersection of
a row and column.

* A cell range is a group of adjacent
cells.
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COMPONENTS OF A WORKSHEET

e Each column has an index letter. Since there are
only 26 letters, and far more than 26 columns on a
spreadsheet, the next columns after column Z are
indexed by the letters AA, AB, AC, and so on until
the last column (XFD, over 16,000).

B3 v
* Each row has an index number. The rows are A - c
numbered from 1 through 1048576. 1
1
* The top left cell in the worksheet is indexed by the 2
letter-number combination Al. 3 |
n

* The active cell is a name given to the cell that is
currently selected. The active cell is referenced in
the Name Box. Notice the thick green border and
the green font color in the row and column
headers.
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WORKING WITH CELLS

* To select a single cell, just click - v fe
it. A B C D E F G

* To select a group of cells, place
your mouse pointer over a cell
and then click and hold the left
mouse button. Drag the mouse

1
3 |
in any direction to select rows, :
2
each.
4
, 5
* To select an entire row/column

columns, or a combination of

of cells, move your mouse over a g
row/column header. The mouse 8
pointer will turn into an arrow. ]
Then click the header to select 10

that row/column.
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WORKING WITH CELLS

YOU CAN MOVE A CELL BY DRAGGING AND DROPPING WITH YOUR MOUSE.

* First, select a cell by clicking on it, A B C D E
thereby making it the active cell. ! ' '

Values
100

* Now move your mouse pointer |
over one edge of the active cell 3 _..HD.
border. The mouse pointer will / 300

3

turn into a four-headed arrow. 400

* Click and drag the cell contents to
a new location. Release the mouse
button to drop the cell in its new
location.
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WORKING WITH CELLS

COPY AND PASTE CELLS:

* To copy a cell, right-click the cell and
select Copy or press Ctrl + C. A | B C D

1 Walues

e This will surround the cell with a 2 : _____ 1C U-Eri

flashing border. 3 | 200!
4 300}

* You can then paste cut/copied data in 51 400 100
one of two ways: by using the right-click 6 200
menu, or choosing a destination cell 7 300
and pressing Ctrl + V. 8 4001

g
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WORKING WITH CELLS

A B A B
THE AUTOFILL FEATURE CAN HELP YOU ENTER A e *
REPEATED OR INCREMENTAL TEXT AND NUMBERS 3 Iz 3 1992
QUICKLY. 4 : | iﬁ
5
6 | 6 1995
* In order to use AutofFill, you need to - 7| 199
establish a pattern. In this example, type 8 | 8 1997
1990 in one cell, and 1991 immediately 15:3- 190 ix
below. Then select both cells. | —> 11| 2000
12: 12 2001
* Next, click and drag the small square 13 li §$:
down the worksheet until the desired :: 15 2004
value is reached. 16| 16 2005
17| 17 2006
1 00
* Once “2011” appears beside the mouse = =
pointer, release the mouse button and 20 | 2011 20 2009
Excel will automatically fill in the 21 el a
27 22 2011.
numbers. = 23| =
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WORKING WITH CELLS

INSERTING AND DELETING CELLS, ROWS, AND COLUMNS

The Cells group, located in the Home Tab,

|ets Ou modif Ce”s Within a WorkSheet, Insert Page Layout Formulas Data ¥ e what you want to do.. Signin gﬂhare
Y y L. AD % [Calib A KN S=Z2®- B |Genel - ['i[;l [;?4 [;“ E;m'”“" i 2 '%Y p
Insert/delete individual cells or Pate = g gy e DeA- === E- | §-% s @8 Condtonsl Farmatss Cel e [ sone rnas
. Formatting~ Table~ Styles~ ormat~ I~ Fier - Select -
roWS/COIumnS. Clipboard Font [ Alignment & Number [ ! Styles y Cells Editing A|
You can also format cells to adjust their | A | 8 | ¢ | b | E 6w . ) K L | M | N | o o]
. . 1 |
height and width, format the worksheet 2
. 3
tabs, and lock down certain cells to make ‘
5‘
them un-editable. 5 A B c D E
; 1_|£1uantit\r Price Sales
. . . 2| calibi -1 - A" A $ - )
 Toinsert a column in a worksheet, right- i = i . A a3 o ’\.E,
. . il B I =0 A eSS
click a column header and click Insert. 2] 4, =2 A S )
. . . 2 5! meliataan $ 13167
* To insert a row, right-click a row header 15| s b Cut $ 209.16
. ge | By Copy
and click Insert. 7 7 B e $1,200.00
18 8| [y FPaste Options: S 175.50
. . 19 1 e
* To delete a row, right-click the row header = % I 5 229.50
. 21| 10 _ 5 299.00
and click Delete. . g PesteSpecial. 5 65.00 i
. . ; | Sheett 12 Insert ' ' D
* To delete a column, right-click the column .. = .. N T
header you want to remove and click 4 Clear Contents

Delete
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WORKING WITH CELLS

USE SEPARATORS TO CHANGE THE SIZE OF ROWS OR COLUMNS.

* To change the size of a row or column,
place your mouse pointer on the line A B + C
that divides the column headers. For ) -
. 1 Price tity Cost
example, if you wanted to change the
size of column B, you would place your
mouse pointer on the line separating B

and C.
A B C

* Your mouse pointer will turn into a line 1 [Height: 54.00 (72 pixels) | Cost

with a small arrow on either side. ?
* When you see this pointer, click and 2

hold the left mouse button to drag the 3'1'

column edge to the left or right. As 4

you drag you will see the size in pixels. 5
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WORKING WITH CELLS

THE AUTOSUM COMMAND WILL FIND THE SUM OF A ROW OR COLUMN OF DATA.

H ©- .
Ho /2 Insert Page Layout Formulas
2D = =
Insert  AutoSum Recently Financial Logical Text Date & Lookup §
Function Used ~ v Time ~ Reference

Function Library

BS 5 Jx

A B C [ D E F
1| Testl Test2 Test3
2 Day1l 6586 5848 7898
3 Day2 9215 4587 6745
4 |Day3 1241 4785 4523
5 | 1
6
SUM - X «~ & || =SUM(B2:B4)

A B = . D E
1 _ITE stl .TE st2 Test3
2 Dayl 6586 5848 7898
3 |Day2 9215 4587 6745
4 |Day 3 1241 4785 4523

i o e i

5 =SUM(B2:B4)
] SUM(number1, [number?], ...)

Jefferson Parish

Library

Click the cell immediately below (if summing a
column of data) or to the immediate right (if
summing a row of data) of the data you want to
sum.

Next, click Formulas Tab, then click the AutoSum
button.

Excel will scan the data in the column/row. The
column or row of data to be summed will be

highlighted by an animated border.

Press Enter to complete the AutoSum command.




Changing default formats includes
things like changing the font color,
style, size, text alignment in a cell, or
apply formatting effects.

* Begin by selecting the cell or cells to
be formatted and simply apply the
desired format by clicking that
button in the Ribbon. Most of
these options are located in the
Home tab.

* You can also make changes to the

FORMATTING CELLS

Formatting text or numbers can make them appear more visible, especially when you have a large worksheet.

orientation of the text within a cell.

- %Wrap Text

#7 Angle Counterclockwise
Qi.‘a Angle Clockwise

LB Vertical Text

T2 Rotate Text Up

|& Rotate Text Down

) Format Cell Alignment
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Book1 - Excel
Formulas Data Review View . £ sh

—J1 &% Calibri o == = & General . F@Conditional Formatting ~ gc"lnsert e z - ';Tv

D g~ B I U~ A A === ~ 0% - % * [ZFFormatasTable~ BxDelete ~ ¥+ P~
Paste N A =

. ¥ e O A E 3= - 90 .0 (7 Cell Styles ~ B Format~ & ~
Clipboard r§ Font [ Alignment = f Number Styles Cells Editing
Cc6 i I JP Library

A B © D E F G H | J
1 {
2 {
3 JP Library
4 {
5
&
"
6 —p| ¥
7 {
8 {
9 {
0,
Sheet! | (@ q

Ready i O - i + 10




FORMATTING CELLS

The Merge & Center button is a

t t I f t - t.tl e Insert Page Layout Formulas Data ( @ Tell me what you want to do Sign in Q_ Share
grea Oo or cen erl ng a I e “D % . Calibri “[11 ARSI = - =2 General - [F\E] g;‘ [Z.(‘ %:::::e '. E: '%Y p
over a table of data. g B [E oA EEEEE A s % [0 o G g | s s

Clipboard Font 1] Alignment ] Number & ’ Styles 7 Cells Editing A~
* The Merge & Center buttonis in ||
. | A B C D E: F G H I J K L M N 0o ‘L
the Alignment group on the o |
Home tab. = |
5| |
* Select the cells you want to 71 1
. = |
merge and center. Then click the ol |
Merge & Center button. il |
2
_ - = :3
= === - = 14|
| 7~ | =t Wp e | A B C D E |
= = = €= 3= | Merge & Center ~ 5 1 I Here is the title of this table. l
18
Alignment - ;z Z Category 1 Category 2 Category 3 }
: 3 |ltem1 |
e The selected cells will merge/zi 4 |Item?2 |
into one big cell, and the text B (st | ® |5 |ltem3 >
. . Ready + 100%
will align to the center of the 6 |ltem4
merged cell. 2
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FORMATTING NUMBERS

By default, each cell is formatted as
“General”, which means it does not
have any special formatting rules.
When you enter data in a cell, Excel
tries to guess what format it should
have. When it doesn’t guess
correctly, you need to change the
format.

You can choose from several options
for formatting by clicking the
dropdown menu in the Number
group, located in the Home tab.

FORMATTING CELLS

Book1 - Excel

1 want to do.

Conditional Formatas Cell

Formatting~ Table~ Styles~

Styles

Page Layout Formulas Data View
& Calibri n -~ A A === General
Ea -
tt ¢ B IU- H- O-A- ===8E3E $-%
Clipboard & Font [P Alignment Number
K3 7 S
A B C D E F H
1 4
2
3 4
4 {
5 1
6 1
7 1
8
e 1
10
1|
12
13
14
15
16|
17]
18
19|
20
21|
22
23 |
24 |
25|
Sheetl | @

Ready

For instance: |General 10
Number 10.00
Currency $10.00
Accounting |S 10.00
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ABC
p

-
o

=
o

i)

ERER

-
"
5 R_.|
Y

%
%

2

10

ABC

More Number Formats...

[

General

Mo specific format

Number

Currency

Accounting

Short Date

Long Date

Time

Percentage

Fraction

Scientific

Text

Signin ,q Share

Emlnserl M Z M AY p
=, 7%
> Delete ~  [¥]~
& Sort & Find &
=1 Format~ & ~ Filter v Select ~
Cells Editing
B
(o}
»
1 + 100%




SAVING A WORKBOOK

* There are two different save commands in Excel: SAVE AND SAVE AS

New File You will be prompted to give the file a You will be prompted to give the file a
name and choose a save location. You name and choose a save location. You
can also specify a file type. can also specify a file type.

Existing File Any changes you made will be applied You have the option to give the file a

to the existing file in its current location. new name and/or a new save location.
You can also specify a new file type. If
you do change something, the original
existing file will not be changed.

* Both save commands are found in the File menu:

6 OneDrive

El:| This PC
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SAVING A WORKBOOK

To save a new document @
that you are working on,
first click the FILE menu.

New

Next click the SAVE option. s

Save
The SAVE AS interface will e
appear because this is the e
first time we have saved this
document and it does not
yet have a name.

Share

Fe_urt

Publish

Close

Click BROWSE to open the
dialog box. After choosing
the location to save your

file, you can enter a name

for the file in the File Name
field.

Options

Then click the Save button
to save it.

JHL
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Sign in
ad [<IE [=]
= A 5 » ThisPC > Documents v O Search Documents e
E Organize v New folder hd o
A Name Date modified Type Size
3 Quick access
Custom Office Templates 2/14/2019 3:32PM  File folder
[l Desktop +
maya 1/2/201911:37 AM  File folder
W Downloads. Media 171172019 10:17 AM  File folder
[ Documents My Digital Editions 1711/20 File folder
=/ Pictures * xgen 1/2/2019 11:47 AM File folder
b Music
B Videos
m Microsoft Excel
¢& OneDrive
3 This PC .
2 File name: | Bookl v
Save as type: | Excel Workbook v
Authors: Patron10 Tags: Add atag Title:  Add a title
[ Save Thumbnail
A Hide Folders Tools ’ Save Cancel
——
—
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MICROSOFT EXCEL EXERCISE

* Open Microsoft Excel. You can double click the Excel icon on the desktop OR

- Go to the START menu

- Click ALL PROGRAMS

- Scroll down to the Microsoft Office folder and click to open
- Click Microsoft Excel

* Once the blank document is open, select columns A through E.

- Click and hold down on column A in the upper left corner of your worksheet and then drag your mouse to the
right to select column B through E as well.

* Adjust the width of the columns.

- With the cells still highlighted, click Format button in the ribbon (this button is located in the Cells group on the
Home tab). Click on ‘Column Width’

OR

- With the cells still highlighted, right-click anywhere in the highlighted area.
- From the menu that appears, click on ‘Column Width’.

* Change the column width to 17.00

- From the dialog box that appears, simply type in the number 17 and click OK.
Continued on next page...

JHL

Jefferson Parish Library



MICROSOFT EXCEL EXERCISE

* Now adjust the height of your rows.

- Click and hold down on row 1.

Next, drag your mouse down to row 30 and release your mouse button. Rows 1 through 30 should now be
selected.

With the cells still highlighted, click Format button in the ribbon (this button is located in the Cells group on the
Home tab). Click on ‘Row Height'.

OR

With the cells still highlighted, right-click anywhere in the highlighted area.
From the menu that appears, click on ‘Row Height’.

* Change the row height to 23.00
- From the dialog box that appears, simply type in the number 23 and click OK.

* Type ‘Monthly Expenses’ into cell A1 and tab over to the next cell by pressing the Tab key on your keyboard.

* Underline and Bold the text in cell Al.

- Select cell Al by clicking on it with your mouse.
- Click the B button and then the U button in the Font group located in the Ribbon.

Continued on next page...
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MICROSOFT EXCEL EXERCISE

* Merge and Center your title.

- Select cells Al through E1 by clicking and dragging across the cells.
- Next click on the Merge & Center button located in the ribbon (this button is in the Alignment group on the
Home tab.

* Enter the following data:

- Type the word Groceries in cell B2.

- Type the word Utilities in cell C2.

- Type the word Insurance in cell D2.

- Type the word Recreation in cell E2.

- Type the word Total in cell A16. Make the text in this cell bold by clicking the B button in the Ribbon.

* Make a list of the months of the year beginning with January in cell A3.
- Begin by typing the word January in cell A3.
- Next, use the Autofill function to fill in the rest of the months of the year. Hover your mouse over the small
black square located in the lower left corner of cell A3 until you see cursor change to a black cross.
- Next, click and hold down on your mouse and drag down the column. You will see a dialog box populate with
each month as you move down the rows. Release your mouse on row 14.
- You should now see January through December listed in Column A.

Continued on next page...
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MICROSOFT EXCEL EXERCISE

* Format cells B3 through E16 for numerical data.
- Begin by selecting cells B3 through E16 by clicking and holding down your mouse on cell B3 and dragging down to
cell E16.
- Next, in the Number group (located on the Home tab), click on the dropdown menu where it says ‘General’ and
select the option for Currency.

* Enter the following numerical data into the cells for the months of January, February and March. You do not need to
type the S - it will automatically populate due to our formatting in the previous step. Simply enter the numbers.

A B C D E
1 Monthly Expenses
2 Groceries Utilities Insurance Recreation
3 January $289.00 $127.39 $77.00 $201.31
4 |February $222.50 $135.99 $79.00 $175.00
5 |March $253.75 $144.17 $79.50 $133.15
6 |April

* Now let’s total the expenses in each column.
- Begin by selecting cells B16 through E16.
- Next, click on the AutoSum button located in the Cells group in the Ribbon. (Found on the Home tab.)
- Your “Total” row should now read as follows:

16 Total §765.25 $407.55 5235.50 $509.46

Continued on next page...
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MICROSOFT EXCEL EXERCISE

Your spreadsheet should look like this.
You can see what the printed version will
look like by clicking on the Print Preview

icon in the Quick Access toolbar oy e

February

OR March
April

- Click on the File tab JMu:

- Next, click on the Print option located in the oy

column of options on the left. August

September
October
November

Save your document. December

- Click on the File Tab.

Total

Monthly Expenses
Utilties Insurance
$289.00 $127.39
§222.50 $135.99
§253.75 514417
$765.25 $407.55

$77.00
$79.00
$79.50

$235.50

Recreation

$201.31
$175.00
$133.15

$509.46

- Click the Save button.
- Choose the Desktop as the location to save your file.

- Click in the File Name box to highlight the name that was auto filled.
- Type your first and last name and then click the Save button.

Close the program.

JHL

Jefferson Parish Library




PART TWO PREVIEW

USING FORMULAS TO PERFORM CALCULATIONS:

* Formulas are mathematical
expressions that operate on cell
contents.

* They are always preceded by an
equals sign (=).

*  Formulae can contain cell
references (like A1) or numbers
(like 23).

* Enter a formula by typing directly
into a cell, or use the Formula
Bar.
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Jx =24+66

D E

|=24+66 |

SUM v B X v

W N -

A B C

Jx

=a2*b2

Quantity Price Sales

5| $ 10.00 [=a2*b2)

19 $ 7.00
11 $ 18.00



WORKING WITH CELLS

.. Precedence
Operator Description
(1=top; 3=bottom)

The percent 1 =90%*M8
operator
The 1 =372
exponentiation =H3"3

USE MATHEMATICAL o

OPERATORS IN FORMULAE

The 2 =5%2
multiplication =D5*C5
operator
The division 2 =48/8
operator =G12/10
The addition 3 =A2+B2
operator =100+25
The subtraction 3 =E7-C7
operator =100-90

Remember order of operations: PEMDAS—Parentheses, Exponents, Multiplication/Division, Addition/Subtraction.
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COMMON KEYBOARD SHORTCUTS

CTRL+A Select entire document/page
CTRL+C Copy selected text/object
CTRL + X Cut selected text/object
CTRL+V Paste selected text/object
CTRL+Z Undo your last action
CTRL+F Find specific text in the current document
CTRL+S Save the current document
CTRL+P Print the current document
CTRL+B Bolds the selected text

CTRL +1 Italicizes the selected text
CTRL+ U Underlines the selected text
CTRL+N Create a new document
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ADDITIONAL RESOURCES

Additional helpful resources can be accessed through our homepage www.jplibrary.net

* From the JPL homepage, click on the Digital Content Tutorials * After the course menu opens, click Full Screen
(blue rectangle) next scroll bar. at the top of the course menu to view tutorials.

«” Full Screen % Close

& Jefferson
. Select Langu v
w = Jm Parish l’j volWw [find books, DvDs, and more... |l Seanch | T

Library JPL Digital Content Tutorials 2

Home | Locations < | Services v‘ Reference = | Policies — | Library Info = | ILL ‘ Catalo Digital Content | Databases | Childrens/Teens/Adults <> | Calendars | Contact Us <

D Find Books, DVDs
A CDs, and more in the @ Online Databases
Catalog Search NOTICE: Repairs require tempora, ¢
Bl Gisa entrance at East Bank Regional a Ask a ibrarian (- 1 **Click and Learn JPL Digital Content Apps >
- Users of East Bank Regional Library » e
Jﬁl. Log.in to your must enter through the administration +4‘3—WL |
account

entrance on the right side of the library.

Computer Classes Adult | eaming

(Brainfuse) s of East Bank Regiona ! **|PL's Basic Computer Skills Learning Guide >

@ Your Library Click fiere formore information Besources (Brainfuse) on the right side of *Homework Louisiana (Tutor.com) Tutorial - Real
f ‘ Free Online Tutoring . s >
\ Text-a-Librarian Q) for K-12 and College ; experts, waiting to help you now
| S ) -k here for more inforr

] Get email reminders
ﬁO_Liuﬁ_i‘aEE

Search the collection
Research Library

. In‘ter-ne't -
, *Internet Basics >

*Joining Cisco Webex Meetings >

Information for all
Jefferson Parish Libraries

1
Belcume a Teen
~ | Volunteer « The Jefferson Parish Library is open to the public, but hours (Pronunciator) H
*
may vary by branch. Patrons can request and reserve items %ﬂ;ﬁ ) |format|0n fO Learn to Use Your Chromebook >
to pick up via curbside service or inside via self-checkout or (Mange) I Lox . .
HOWTO counter service. Distanced computers will be available for rson Pa Fis h LI

RENEW ITEMS: use by advanced reservation and distanced seating will be *Zoom - Let's learn to use it! >

available inside for patrons use. Parish Library is open to tk

ranch. Patrons can reques
curbside service or inside
e. Distanced computers v

‘ed reservation and distan [y Ancestry Library Edition Tutorial -- Access Billions
le for patrons use 1t ¥ ; >
2o of Genealogical Records

1. Online thru
Online thru = Meeting and study rooms will be open, but are subject to
your account AR e
the capacity limitations established by the State of Louisiana
2. Call TeleCirc at & Jefferson Parish. Patrons must wear a face covering or
5 mask (which covers both the nose and mouth) and undergo
(504) 885-8588 a temperature screening prior to entering.

Advanced Internet Search Techniques >

L.
+ Single and larger study rooms will be available with limited itudy rooms will be open,
capacity and time management. mitations established by t AtOZ World Food >
- . ol
* A reservation for a meeting room is required. There will be rish. Patrons must wear a
a limited capacity for each individual meeting room due to :overs both the noseand r g

ial distancing. Click here fi ti ities. 5 st i - i
| soca distancing. Click here for meeting room capaciti y o » y screening prior to enterif . Auto Repair Source - Automotive Information >

Jefferson Parish Library




ADDITIONAL RESOURCES

* From the library’s homepage, click on the JPL Digital
Content link or the Digital Content menu tab.
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Read full digital copies of your
favorite magazines on a computer,
tablet, or mobile device using the
free Zinio Reader app!

Click here for more information.

(<1l ]

Through our website, patrons now have unlimited multi-user access to
complete digital magazines, which can easily be viewed on most

Additional helpful resources can be accessed through our homepage www.jplibrary.net

* Then click on the LinkedIn Learning icon to access

online training using your library card number and pin.
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Lynda.com is now LinkedIn Learning.




NOTES

Jefferson Parish Library authorizes you to view and download materials such as this handout at our web site (www.jplibrary.net) only for your personal, non-commercial
use, provided that you retain all copyright and other proprietary notices contained in the original materials on all copies of the materials. You may not modify the
materials at this site in any way or reproduce, publicly display, perform, distribute or otherwise use them for any public or commercial purpose. The materials at this site
are copyrighted and any unauthorized use of any materials at this site may violate copyright, trademark, and other laws. If you breach any of these Terms, your
authorization to use any materials available at this site automatically terminates and you must immediately destroy any such downloaded or printed materials.
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